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1 Introduction

1.1 The translation environment
memoQ is an advanced translation environment. This document explains what a translation environment is and how you can benefit from using memoQ.
Translation: During translation, you transform text in one language into text in another language, according to the cultural specifics of the target culture. The texts you work on are usually similar to
each other; if your clients are a manufacturer of goods or a service provider, most of the source documents are related to their fields of activity. You are likely to receive similar documents from the
same customer, or you might receive multiple documents on the same topic such as law or user
manuals.
The translation environment takes advantage of these similarities. The most important components
of memoQ include the translation memory, the LiveDocs corpora, the term base, and of course the
translation editor (performing the task of the word processor) including AutoPick and Muses.
When you translate a document in memoQ’s translation editor, regardless of the type of the document, the editor automatically takes care of all formatting. The text is divided into segments. In
memoQ, a segment is more or less the same as a sentence. In the translation editor, you proceed
from one segment to the next. After you translate a segment, you add it to the translation memory.
Translation memory: The translation memory is the traditional way to recycle earlier translations. It
stores pairs of segments: one member of the pair is in the source language, and the other member is
its translation. As you proceed in the text, memoQ checks if the translation memory contains a sentence that is similar enough to the one you are translating. If there is such a sentence, it will appear
as a translation suggestion, and memoQ will indicate the difference between the current sentence
and the stored sentence.
Recycling documents (alignment and LiveDocs): In addition to the conventional translation process,
you can directly use documents from previous translations – the same way as translation memories.
This is the LiveDocs feature of memoQ: you can create a corpus of documents. A LiveDocs corpus can
hold pairs of documents (alignment pairs), bilingual documents, monolingual documents, and binary
(non-text) files. An alignment pair consists of a source-language document and its translation. When
you add an alignment pair to a corpus, memoQ aligns the documents: it matches the sourcelanguage sentences to the target-language sentences by mathematical means. Once the alignment is
finished, and the document pair is added to the corpus, memoQ immediately offers matches from
the document contents.
The automatic alignment algorithm in memoQ is rather accurate, but mismatches can still occur.
When you encounter a mismatch (misalignment), you can open the document pair in the alignment
editor. After you correct the alignment in the document pair, memoQ will automatically give you the
corrected matches.
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Immersive editing: Immersive editing enhances you in translating content. It includes Predictive Typing and AutoPick. Predictive Typing suggests you words from term bases, non-translatables, autotranslatables and Muses. A Muse provides you subsegment suggestions from translation memories
and corpora while you type in the translation grid. AutoPick allows you to pick numbers, tags, and
dates from the source cell and to insert it into the target cell.
Term bases and term extraction: When you use a translation memory or a LiveDocs corpus, you
build a database of whole sentences – or, to be more precise, segments because the unit of translation can also be a paragraph, or even a phrase that is smaller than an entire sentence. If you want to
build a glossary of certain expressions that occur inside a segment, you can use a term base. A term
base contains entries with terms – words or phrases – in multiple languages, and, optionally, further
data. memoQ’s translation editor automatically highlights the terms found in the term base, and displays their translations in a list: from this list, you can insert them into your translation with a single
keystroke or a mouse click.
If you do not have a term base when you start working, you can ask memoQ to read through the
source documents, and put together a list of potential terms. This process is called term extraction.
Text analysis: In a translation environment, the statistical analysis of text also plays an important
role because it enables you to predict your workload. A key factor of translation environments is
productivity. You achieve productivity if a single unit of work takes less time in the translation environment than, for example, in a traditional word processor – while keeping up the quality of your
work. memoQ’s statistics module analyses the text and estimates how much you will save using the
translation memory and the LiveDocs corpus.
memoQ is an integrated environment: you work in a single software application that provides you
with all the functionality you need when you are translating. You do not need to work in other programs in parallel.

1.2 Productivity
The productivity increase you get from translation environments depends very much on the type of
the text. If the text is very repetitive – for example, it is a user manual or a technical specification –,
the productivity gain can be as high as 70–80%. However, in the case of “normal” texts such as textbooks it is 10–30%. With letters, the use of a translation environment may not even result in any savings.
In the translation memory, all segments translated are stored together with their target-language
equivalents. memoQ can analyze the text, and look for segments that are similar to previously translated ones. memoQ can also calculate the degree of similarity. If a segment is already stored in the
translation memory or the LiveDocs corpus – that is, the text is exactly the same as in the document
–, then it is a 100% match or a context match. If the translation memory or the LiveDocs corpus contains a similar segment only, then it is a Fuzzy match.
The statistics module of memoQ offers an innovative feature: this is homogeneity analysis that works
even when you do not have a translation memory or a LiveDocs corpus of previous translations. Ho-
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mogeneity analysis discovers the internal similarities within the text you are working on. This provides a more accurate estimate of the effort it takes to translate the text.
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2 Installation and system requirements

For instructions on installing and activating memoQ, please refer to the memoQ installation and activation guide, available from the Kilgray website (http://kilgray.com/resource-center/user-guides).

2.1 Changing the user interface language
By default, memoQ runs in English. However, you can change the language of the user interface from
within the program. Here is how to do it:
1. Start memoQ if it is not already running. The main memoQ window appears, and displays the
Dashboard.
2. From the Tools menu, choose Options. The Options dialog appears.
3. In the Category list on the left, click Appearance. On the main pane, memoQ displays the settings
for controlling the appearance of the program.

4. In the User interface language drop-down list, choose the desired language, and then click OK.
5. Close memoQ, and start it again. Next time the program appears with commands and messages
in the selected language.
Note: By default, you can choose from English, German, French, Hungarian, Russian, Portuguese,
and Spanish. Depending on your location, Japanese might also be available. Further languages are
being added continuously, so you might as well see a more extended list.
Note: The memoQ Help is available in German when you switch to the German user interface.

memoQ integrated translation environment

Page 7 of 38

quick start guide

3 The translation process

3.1 Projects
In memoQ, translation jobs are organized into projects. A translation project consists of the following
items:
1.

Translation documents (unlimited number – practically up to a few hundred)

2.

LiveDocs corpora, consisting of bilingual documents, source-target document pairs, monolingual
documents, and binary files (unlimited number, remote or local – practically one or two)

3.

Translation memories (unlimited number, remote or local – practically up to five or six)

4.

Term bases (unlimited number, remote or local – practically up to five or six)

5.

Settings and light resources: segmentation rules, auto-translation rules, translation memory settings, quality assurance settings etc.

6.

Muses for subsegment suggestions while translating (unlimited number, local – practically one or
two)

Resources such as translation memories, term bases, segmentation rules, auto-translation rules etc.
can be stored locally on your computer or they can be available over the network from a memoQ
server. You can assign these resources to multiple projects. memoQ registers translation memories,
term bases, and other resources stored on the computer, which can be used in any project – even in
multiple projects at the same time.

3.2 Translating in memoQ
In memoQ, the translation process consists of the following steps:
1. Creating a project. You select the translation documents, and then you specify the translation
memories and term bases to use. When you create a project, memoQ imports the contents of
the source documents into its own workspace, and ensures that the translation can be exported
in the same format as the original. While you create the project, you can also create new translation memories and term bases. After creating the project, its contents and settings can be modified as necessary.
2. Translation. You type the translation in a special word processor called the translation grid. In
memoQ, there is a separate translation grid for each translation document, opening in a separate
tab within the memoQ window. During translation, memoQ automatically searches the translation memories, LiveDocs corpora and term bases assigned to the project. In a project, you can
edit multiple documents simultaneously, but you cannot work on multiple projects at a time.
3. Delivery. After finishing the translation, you instruct memoQ to export the translated text. The
program saves the translation documents to the hard disk in the same format as the original
document – using the formatting information that was retrieved when the document was im-
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ported. You can export the text anytime during translation, and you can continue to work on the
project even after exporting the translated text.

3.3 Getting around in memoQ
In memoQ, you can work with one project at a time. memoQ displays the contents and settings of
the project in the Project home tab.
When you are working, memoQ opens other tabs next to Project home. You can navigate the tabs by
clicking them on the upper part of the memoQ window, or pressing Ctrl+Tab repeatedly, until you see
the desired tab.

You can use the tabs to access the translation documents and the contents of the heavy resources
(translation memories, LiveDocs, Muses and term bases).
Note: In memoQ, almost all settings are resources – pieces of data that control how memoQ behaves while you do your work. Translation memories, term bases, Muses and LiveDocs corpora
are called heavy resources. Other resources such as segmentation rules, auto-translation rules,
quality assurance settings, spelling ignore lists etc. contain smaller amounts of data: they are the
light resources. The greatest advantage of putting all settings into resources is that you can save
them in files and load them again when necessary – for example, on another computer. In other
words, you can exchange them with fellow memoQ users, and – if you have the appropriate
memoQ edition and permission – you can also publish them on memoQ servers.
memoQ remembers the status of the projects. If you close memoQ, and open it again on the next
day, it will display the Dashboard where you can open your recent projects. When you open an exist-
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ing project, memoQ displays the same tabs that were open when the project was last closed, and automatically switches to the tab you were last using.
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4 Creating and modifying a project

4.1 Creating a project
When you start memoQ, it will display the Dashboard. In the Dashboard, you see a list of your projects, information on your current memoQ license, and popular commands to manage projects. Here
is where you start creating a new project.

memoQ uses a wizard to create translation projects. To create a project, follow the steps below:
1. From the Project menu, choose New Project. Alternatively, click the Create a new project link in the
Dashboard. The first page of the New memoQ project wizard appears.
2. Enter the name of the project, and select a source and a target language. You can also fill in the
Project, Domain, Client and Subject text boxes. After entering these details, click Next.

3. In the second page of the wizard, you can add documents to translate. Click the Import command
link below the empty document list. An Open dialog box appears: browse for the files you want to
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add to the project and select them. You can select multiple files even with different file types at
the same time. After selecting the files, click Open.

Alternatively, you can click the Import with options… command link to add more files to the project. If you choose this option, you can change the filter configuration for the file import. You can
include many types of files in a project. Use this document import option to select or create a
document import filter or to change the document import settings. After adding the documents,
click Next.
4. On the third page of the wizard, you can select translation memories for your project. This wizard
page lists all available translation memories in the language pair of the project. If you have an
English-German project, memoQ will not list English-Polish translation memories.
Note: Translation memories can be reversible. This option is set by default when you create a
translation memory. Therefore, you will also see German-English translation memories listed
in an English-German project. The TMs with the reversed language combination can be assigned to the project as reference TMs only.
To add one or more translation memories to the project, click the check box before the name of
each translation memory. Translation memories you select this way move to the top of the list.
In this wizard page, you can also create a new translation memory by clicking Create/use new. After adding translation memories, click Next.
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The translation memories you use in the current project are displayed at the top of the list. One
translation memory is always listed in bold, and marked as primary. This is the primary translation
memory. When you are writing your translation, and you confirm the translation of a segment,
the resulting translation unit (source-translation segment pair) will be saved into the primary
translation memory. memoQ uses the other translation memories for reference only. You can select another primary translation memory any time after creating the project.
5. In the fourth page of the wizard, you can select term bases for the project. memoQ lists all available term bases that support the languages of your project. If you have an English-German project, memoQ will not list term bases that have English, French, and Spanish, or German and
Polish.
To add one or more term bases to the project, click the check box before the name of each one.
You can also create a new term base by clicking Create/use new. After adding the term bases, click
Finish.

memoQ creates the project, and displays the contents of the project in the Project home tab.
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4.1.1 Modifying the current project
When the New memoQ project wizard is completed, or you open an existing project, the Project home
tab appears in the memoQ window. In Project home, you can manage and modify all settings of the
project.
Note: In the New memoQ project wizard, you can click Finish as early as in the first page, after filling
in the project name and the two languages. Then you can use Project home to add translation
documents, translation memories and term bases, just like in the wizard’s dialogs.
The Project home tab has seven panes. To select a pane, click an icon on the left: Overview, Translations, LiveDocs, Translation memories, Term bases, Muses and Settings.

4.2 Creating a translation memory
If you click Create/use new in the third page of the New memoQ project wizard or in the Translation
memories pane of Project home, the New translation memory dialog appears.

You can customize options for new translation memories. Click the Help button to view the memoQ
Help for detailed description. If you start creating a translation memory in an open project, all you
need to do is enter a name, then click OK. The languages of the translation memory are taken from
the language pair of the project. Translation memories created this way are automatically assigned to
the project.

4.3 Creating term bases
If you click Create/use new in the fourth page of the New memoQ project wizard or in the Term bases
pane of Project home tab, the New term base dialog appears.

memoQ integrated translation environment

Page 14 of 38

quick start guide

You can customize options for new term bases. Click the Help button to view the memoQ Help for detailed description. If you start creating a term base within an open project, all you need to do is enter
a name, then click OK. The languages of the term base are taken from the language pair of the project. A term base created this way is automatically assigned to the project.

4.4 Adding further resources
After you finished creating your project, you can add a LiveDocs corpus or a Muse or other resources
to your project. Open the just created project from the Dashboard, and in Project home, the click LiveDocs icon to add a corpus, click the Muses icon to add a Muse. Click the Settings icon to add further
resources such as QA settings or export path rules. See the memoQ Help for a detailed description.
To access the Help, press F1 anywhere in memoQ.
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5 Translation and the translation grid

5.1 Opening a document for translation
In Project home, click the Translations icon. In the document list, double-click the name of the translation document you wish to work with. If the document is already open, click its tab on the upper part
of the memoQ window.
You can have many documents open at the same time. You can switch to a document by clicking its
tab or by pressing Ctrl+Tab.
You can close a document tab by clicking the

button on it, or pressing Ctrl+F4.

5.2 Editing the translation
On a document tab, document contents are laid out in a two-column table. The left column contains
source-language segments. You write the translations in the cells in the right column. To start translating, click in the right-hand cell in the first row.

In certain document formats, memoQ displays the formatted text in the HTML preview pane below
the translation grid, so that you always see where and how the actual segment appears in the translation document – and how it would be displayed, if the translation document was exported. The
translation preview feature is available for the following formats: HTML documents (web pages), Microsoft Word documents and Rich Text Files, Microsoft Excel files, Microsoft PowerPoint files, TTX
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and XML documents. You may also get a preview for other formats if you are provided with a XSLT
file.
Here follows a summary of the most important actions you can perform in the translation grid. See
the memoQ Help for detailed description. To access the Help, press F1 anywhere in memoQ.

5.3 Confirming segments
When you finish translating a segment, press Ctrl+Enter, or, from the Translation menu, choose Confirm. memoQ saves the translated segment into the document and to the primary translation
memory of the project, and then proceeds to the next segment.
You can also confirm a translation by pressing Ctrl+Shift+Enter. You can also choose Confirm Without
Update from the Translation menu. If you do this, memoQ will not save the translation in the translation memory. You use this command when there is no translation memory assigned to the project, or
when there is one but you do not want – or you are not allowed – to add segments to it.
You do not need to save the document during translation because memoQ automatically saves every
single change to the hard disk very shortly after you make them.

5.4 Joining and splitting segments
If the current segment does not form a meaningful unit in itself, but makes sense together with the
next one, click
or press Ctrl+J. memoQ joins the current segment with the next one.
If the current segment seems to contain more than one sentence (or meaningful units), you can split
it into two segments: click on the appropriate position in the source cell, then click
or press Ctrl+T.
memoQ will split the segment into two at the specified position. Afterwards, click in the right-hand
cell in the first one of the new segments, and proceed with the translation.

5.5 Using translation results
When you confirm a segment, memoQ will move on to the next segment. It will also automatically fill
in the segment with the best (highest-ranking) suggestion from the translation results list.
Note: When you open a document for translation, memoQ will not insert the highest-ranking
translation results automatically in the first segment. Neither will memoQ insert a translation result into a segment if you get to it by just clicking it or pressing the arrow keys to navigate up and
down in the grid.
No matter how you reach a segment, memoQ will automatically look up the segment text and its
parts in the translation memories and term bases of the project. memoQ will also match the segment
against the auto-translation rules and non-translatable lists. The results come in the form of suggestions, listed in the Translation results pane, appearing to the right of the actual translation grid. The
suggestions are ranked: translation memory matches come first, and, among those, the one with the
best match rate will appear at the top of the list.
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Important: you can also customize this default order. For this, go to Tools > Options > Appearance >
Lookup results. Use the Move up and Move down buttons to rank the translation results. According to

your ranking, the matches will appear in the translations result pane.
Note: For more information on resources such as the auto-translation rules and the nontranslatables, see memoQ Help.

If memoQ does not fill in the segment automatically, or you want to find a better match for your
segment, you can navigate and review the list, and insert suggestions manually:
If the translation memories contain a source segment that is identical or similar enough to the
current source segment – in other words, if the current segment or a similar one was translated
before –, it will appear at the top of the numbered list on the far right, marked with red color. The
list includes suggestions (hits) retrieved from the translation memories and the term bases: hits
from translation memories come first (in red), followed by hits from term bases (in blue). You can
navigate the list using Ctrl+Up arrow and Ctrl+Down arrow. To insert the target equivalent from the
selected hit into the translation, press Ctrl+Space.
Important: The match rate shows the similarity between the source text in the segment and the
source text that memoQ found in the translation memory. If the match rate is 101% or 100%, the
source text and its formatting in the current segment is the same as in the translation memory. If
the match rate falls between 95% and 99%, the text is the same, but the formatting and the numbers might be different. If the match rate is below that, there are differences in the text. When
you select a suggestion in the list, memoQ will show the differences in the three fields below the
list. If the match rate shows 102% match, this match comes from x-translate (a document based
pre-translation).
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When a word or expression within the current segment is found in the term bases assigned to the
project, memoQ will highlight the occurrence with a cyan background. The highlighted expression
and its target equivalent will appear in the numbered list on the far right, marked with blue color.
If there is more than one hit in a segment, they appear in the order of their appearance. You can
navigate the list using Ctrl+Up arrow and Ctrl+Down arrow. To insert the target equivalent from the
selected hit into the translation, press Ctrl+Space.
You can also insert a suggestion by typing its number: press and hold down Ctrl, then type the number of the hit. The number appears between the source text and the target text, in the red or blue (or
orange, or purple, or green) box.
The comparison fields under the translation results pane show the original source segment, the
source segment of the translation memory hit similar to the source segment, and the target segment
of the hit. Color coding is used to highlight differences between these segments (dark blue items are
to be inserted, red items are to be deleted, light blue items are to be changed).
The confidence (or the fuzzy match rate) of the translation memory hits is shown in white before a
dark grey background in the lower right corner of the memoQ window.

5.6 When there is no automatic suggestion: finding information in translation
memories and term bases
At times, you might be unsure how to translate a word or expression in the current segment, and
chances are you do not receive any suggestions for it on the hit list – because the sentence is not
found in the translation memories, and the word or expression is not found in the term bases. In this
case, you can check for the problem word or expression itself in the translation memories. To do this,
use memoQ’s built-in concordance facility: select the word or expression in the source cell, then
press Ctrl+K, or, from the Operations menu, choose Concordance. If the translation memories have
segments containing the word or expression, memoQ will list them in a separate window, along with
their translation.
You can switch between two concordance views: Three column view or the Source+Target view. In the
Source+Target view, the Meta information such as creator and creation time are shown.
You can now also edit the TM entry from the concordance window. Right-click in the Target column,
and choose Edit Entry.
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If a word or an expression occurs more than twice in the translation memories, memoQ can perform
the concordance automatically. In such cases, the word or expression will be marked with orange
color. There is no need to select text in the source cell: memoQ will find out for you what to concordance for.
You can also choose Concordance from the context menu, then memoQ will perform a concordance
search within the concordance window.
Check the Guess translation check box. memoQ will then guess the translation of a word. The hits will
be marked in green.
Alternatively, you can check for a part of the problem word or expression in the term bases. To do
this, use memoQ’s built-in term base lookup feature: select a part of the word or expression in the
source cell, then press Ctrl+P, or, from the Operations menu, choose Look up Term. If the term bases
contain terms containing that part of expression, memoQ will list them in a separate window, along
with their translation.
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5.7 Creating your own term base
While working in the translation grid, you can add any number of terms to a term base (You can select the primary term base the same way as the primary translation memory – in the Term bases pane
of Project home.). If you find a repeated expression in the source text that you wish to add to the
term base, select it and press Ctrl+E, or, from the Operations menu, choose Add Term. The Create term
base entry dialog box appears. You can choose from the list of attached term bases in which one you
want to add the term to.

In the drop-down list next to Term bases, choose the term base you want to add the term to. The
term base selection is only available if you have more than one term base assigned to the project.
In the text box on the right, enter the translation of the word or expression, and then click OK.
memoQ will immediately add the term pair to the term base. Further occurrences of the term will
automatically be highlighted. If the target cell already contains the translation of the term you want
to add, you can select both the source and the target expressions, and then press Ctrl+Q, or, from the
Operations menu, choose Quick Add Term. memoQ will automatically add the term pair to the term
base without displaying the Create term base entry dialog box.
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5.8 Pre-translation
If the translation memory is likely to contain many segments from the source text, you can insert
them all at once by instructing memoQ to pre-translate the document. In the Translation menu,
choose Pre-Translate. You will be prompted by a dialog where you can define what kind of matches
memoQ should insert during the process and what it should ignore. You can also use Fragment assembly. See the memoQ Help for detailed description.
Important: This is what you do when something bad happens to your document. It is extremely difficult to lose your translation in memoQ because your translation is always saved to two locations: to
the document and the translation memory. If, for some reason, you cannot access or deliver your
document, you can import the source document again into your project (go to Project home, then use
Reimport to import it again), and then use Pre-translate to restore your translations from the translation memory. See also the Knowledge Base article: http://kb.kilgray.com/article/AA-00288

5.9 Filtering and sorting
If you want to see only those segments in the translation grid that contain a specific word on the
source and/or target side, or that have specific segment types, or if you want to see the segments in
a specific order, you can use the filtering and sorting icons above the translation grid. If you want to
reset filtering, click
. If you want to reset sorting, choose No sorting in the appropriate drop-down
list of the toolbar. See the memoQ Help for detailed description.
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5.10 The status of segments
Next to the target segment, there is a small information panel displaying the status of each individual
segment. The status of a segment in memoQ can take five different colour-coded values, as described below:
Grey

The segment has not been edited (yet).

Orange

The segment has been edited but is not confirmed.

Green

The translation is confirmed. When the translation is confirmed you see a green
tick instead of the red cross.

Blue

The target segment text was automatically inserted by memoQ during pretranslation. In this case, you can see a percentage value other than zero before the
blue background. An exact match is indicated by the value of 100% (or 101%),
fuzzy matches are indicated by a lower percentage.

Purple

The text in the target segment was compiled from fragments by memoQ during
pre-translation. There was no acceptable translation memory hit for the entire
segment but there were some for parts (fragments) of the text. It can also come
from machine translation if you have a MT plugin enabled (Tools > Options > Machine translation).

Red

When you set a segment status to Rejected (Shift+Enter), the segment status is
shown in red.

5.11 Using formatting tags
When importing a source document, memoQ extracts the text content from the document files and
hides everything else (formatting, styles, images etc.) from the translator. To have these elements
displayed again, you need to export the translations back into the original format. From the original
formatting, memoQ’s translation grid displays bold, italic and underline font styles only, which you
are free to change. If the whole source segment is formatted the same way (e.g., the whole segment
is in italics), the same style is used automatically in the target segment. If just a part of the source
segment is formatted this way, format the target equivalent by selecting it and pressing Ctrl+B, Ctrl+I,
or Ctrl+U.
All other formatting instructions or images within the segment are converted into a formatting tag
for the time of translation, and marked by purple numbers between curly brackets {1} called formatting tags. A segment containing highlighted text might appear like this:

Locate the position within the target cell where you would insert the tag (this is the place where the
context in the target text is equivalent to the context in the source text) and press F8. You can also
press F8 while typing the translation.
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memoQ can export the document back into the original format only if you insert all formatting tags
into the target segment, each at the appropriate positions. You cannot change the order of the tags:
pressing F8 will always insert the subsequent tag. If you move the cursor backwards, then press F8,
memoQ renumbers the tags in the target cell. An error notification ( icon) will remain there until all
formatting tags are inserted, or all unnecessary tags are deleted from the target cell.
The tags between the curly brackets are “legacy” tags. For most file formats, such as Microsoft Office
Word 2007 (DOCX) documents or HTML files, memoQ now uses so-called inline tags. With these tags,
you might get some information about the content of a tag; you can change the order of the tags;
and, if you are technical enough, you can even create and insert new tags. Inline tags look like this:

When you are editing the translation, you can press F9 to insert the next inline tag from the source
cell.
In case of some document formats, memoQ displays a formatted preview of the text in the Preview
pane, below the translation grid. The preview will help you how you place the formatting tags, and it
will reveal the actual formatting of the text. This means that you will see if part of the text is in a different font, different color, or set to subscript or superscript:

memoQ refreshes the preview as you proceed with translation. This is why this functionality is also
called the real-time preview. Real-time preview is available for the Microsoft Office file formats (DOC,
DOCX, PPT, PPTX, XLS), HTML (web pages), TTX and XML.
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5.12 Using predictive typing
When you type in the target cell of the translation editor, memoQ predicts your typing and suggests
how to complete the word.
To enable predictive typing, go to the Translations menu, and select Predictive Typing. Click the Enable
predictive typing check box. When you now translate, memoQ will suggest you words from several
sources (term bases, non-translatables, auto-translatables). The list with suggestions opens automatically after you have typed in a few characters. You can then choose the word from the list being displayed. Close the list by pressing Esc, or simply ignore the list. You can navigate the list by using the
Up/Down arrows on your keyboard. Insert the selected item by pressing Enter.

Note: If you have assigned a Muse to the project, memoQ will also suggest hits from the Muse. A
Muse can be trained with translation memories and LiveDocs corpora. You can then choose the
subsegment suggestions from the list of suggestions in predictive typing.

5.13 Using AutoPick
To enable AutoPick, go to the Translations menu, and select Predictive Typing. Navigate to the second
tab, and then check the Enable AutoPick check box. When you now translate, you can press the Ctrl
button on your keyboard to switch on or off the AutoPick. When you switch it on, you can pick tags,
numbers, URLs, E-mail addresses and dates from the source cell and insert them in the target cell.
AutoPick marks the items than can be inserted into the target cell:
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You can navigate the list by using the Up/Down arrows on your keyboard. Insert the selected item by
pressing Enter.

5.14 Using memoQ Web Search
The memoQ web search feature allows you to set up frequently consulted websites such as dictionaries, encyclopedias or search engines. memoQ automatically starts searching a highlighted word or
phrase in one or more of these pre-setup sources.
You can invoke the memoQ web search by pressing Crtl+F3 in the translation grid, or by right-clicking
in the translation grid and choosing memoQ Web Search.

You can also make changes to the web search settings. From the Resource console, select memoQ Web
Search, and click the Edit command.
Note: You need to enable the web search for your projects in Tools > Options > Default resources. Select memoQ Web Search, and check the check box of the web search resource you
want to use.
Check the check boxes of the search providers which you want to use. In the Search provider column
you find the default search providers. Click the bin icon to remove a search provider from the list.
Click Add new to add a new search provider. Click the Edit icon (
dialog to edit a provider.
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6 Delivering the translation

6.1 Delivering the documents in the original format
After finishing the translation, you need to deliver the translated documents to your client in the
same format as the source documents, together with the translation memories in most cases. The
easiest procedure is described below. See the memoQ Help for detailed description.
1. Make sure that every segment is translated and all formatting tags (purple numbers in curly
braces: {1}) are copied into the target text. If there are untranslated segments or missing formatting tags, memoQ displays an error report before performing the export, and, in case of missing
formatting tags, it refuses to export the document.
2. In Project home, click the Translations icon.
3. Select all documents in the document list view, and click Export (stored path) below the list view.
memoQ will check if all segments are translated and confirmed, and all formatting tags have
matching pairs in the target text. If the checking fails, the Errors in documents message box appears:

To review and correct the segments where memoQ found errors, click Yes to proceed to the Resolve errors and warnings tab.
Note: If you want to export the document you are editing, you do not need to switch back to Project home. Instead, from the Project menu, choose Export active document. memoQ will export the
current document to the default export location. (It will not ask you for the folder and name of
the exported file.)
4. If there are no errors preventing the export of the documents, memoQ will export each document to the path stored during importing. By default, during the export, a new folder is created
at the original file path, having the three-letter abbreviation of the target language for name, and
the documents are saved into that folder with the original file names (in case of the English language, the name of the target folder will be eng).
5. The progress of the document export is indicated by a progress bar. memoQ will report when the
export is finished.
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6.2 Delivering the documents in bilingual files
Your client might want to check your translation in memoQ. To provide for this, you need to export
bilingual documents that can be opened in memoQ. (You can also add such files to the project the
same way as other document types).
1. In Project home, click the Translations icon. In the document list, select the documents you want
to export as memoQ XLIFF. To select multiple documents, hold down the Ctrl key, then click the
name of each document, one after the other.
2. Click Export bilingual below the document list. In the Bilingual export wizard, select the memoQ
XLIFF option. memoQ will let you select one folder for all selected documents.
Opening a memoQ bilingual XLIFF document is the same as adding it to a memoQ project. In the
Translations pane of the Project home tab, click Import with options… below the document list. Navigate
to the memoQ XLIFF (*.mqxlz) files, and click Open.
Important: memoQ can also export the documents to bilingual Word documents. These files can be
processed in other translation tools such as SDL® Trados™ and translation editors.
memoQ can also export the document in a Rich Text Format (RTF) file that contains the text in a table
that is similar to the translation grid (a two-column RTF file). You can use these RTF documents to review translations in Microsoft Word instead of a translation environment, and update the memoQ
project from the reviewed files. For more information, see the memoQ Help.

6.3 Delivering translation memories
Your client might also ask for the translation memories created during translation. If your client is using a translation tool other than memoQ, you must deliver the translation memories in the standard
TMX format. To export a translation memory into a TMX file, follow the steps below:
1. In Project home, click the Translation memories icon. In the list, select the translation memory you
want to export.
2. Under the list of translation memories, click Export to TMX. memoQ prompts for the name and location of the TMX file to create, then performs the export.
The resulting TMX file can be imported into any TMX-compatible translation tool, even into another
instance of memoQ.
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7 Working from a handoff package

If your client uses memoQ too, you might receive your assignment in the form of a handoff package.
memoQ can create a project from a handoff package: it contains source-language documents, translation memories, term bases, and LiveDocs corpora – everything you need in a translation project.
When your client sends you a handoff package, the way to start working and to deliver your work is a
bit different.

7.1 Creating your project from a handoff package
You usually receive the handoff package in an e-mail. It is a file with the .mqout extension. To start
your project from this file, do the following:
1. Close memoQ if it is running.
2. Open the e-mail. The handoff package will be an attachment to the e-mail. Double-click the icon
of the handoff package. The icon looks like this:

3. memoQ starts automatically, and displays the Import handoff package dialog:

Note that the name of the project consists of the name of the original project, the name or identifier of the user, and the role of the user. The original project in the example is called ‘Winnieille-Pu versioned’, the name of the user is ‘kb’, and the role of the user is Translator.
4. When you click OK in this dialog, memoQ automatically creates a project, and displays the Project
home tab with the Translations tab open.
Caution: Before starting to work, check the Translations, LiveDocs, Translation memories, and Term
bases panes to see if you received all necessary documents and resources.
You can then complete the translation the usual way.
Important: You do not need to import the handoff package again if you want to return to your
work. After you import the handoff package, you can open the project from the Dashboard, just
like projects that you create.
Troubleshooting: You might be unable to join or split segments during translation. The project
manager who created the handoff package has a setting to disable joining and splitting. Similar
settings may prevent you from seeing the preview or exporting the documents in the final translated format.

memoQ integrated translation environment

Page 30 of 38

quick start guide

7.2 Delivering your translation
If you work from a handoff package, you need to send back a delivery package. To create a delivery
package, navigate to the Translations pane of Project home, and click the Deliver/return link below the
document list. memoQ will save a file with the *.mqback extension. You need to attach this file to an
e-mail you send to the project manager.
Note: You do not have to complete the entire work before you can create a delivery package. After you finish a significant amount of the translation (for example, you complete one document),
you can use the Deliver/return command to save a delivery package that contains a partial delivery. From the *.mqback file, the project manager’s memoQ version will know that it is a partial delivery, and will accept further deliveries.

7.3 Working with other package types
You can also import other packages. memoQ supports:
•

the import of SDL Studio packages (*.sdlppx). SDLPPX files are ZIP files and contain a descriptive XML, the documents for translation in SDLXLIFF format and translation memories.

•

the export of SDL Studio packages. You can deliver a project from the Translations pane of
Project home. Choose the Export dialog command link to deliver individual SDLXLIFF files.
Choose the Export (stored path) command link to create a return package (*.sdlrpx).

•

the import of STAR Transit™ XV and STAR Transit™ NXT packages. This enables you to process jobs in STAR Transit™ format. You receive STAR Transit™ projects in a compressed file
with the *.pxf or the *.ppf extension. The reference material is stored in the translation
memory which you create or choose during the import wizard.

•

the export of STAR Transit files. You can deliver a project by choosing Project > Export Transit
package or from the Translations pane of Project home > Export (stored path). When you use Export (stored path), memoQ only saves the selected files into the delivery package (*.txf file).

•

the import and export of TIPP packages. For more information, see the memoQ Help.
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8 Working on online projects

You might need to work on an online project that exists on a memoQ server. Your memoQ desktop
application can access projects and resources on memoQ servers through the Internet.
You usually receive the assignment in an e-mail. It usually contains a task description. To start working on an online project, you need the following details:
•

The Internet address (URL) of the server. Example: memoq.translationcompany.com

•

Your user name

•

Your password

•

The name of the project to work on

You might also receive an automated e-mail directly from the memoQ server, which contains a task
description file. The task description file supplies the Internet address of the server, the name of the
user, and the name of the project to work on. You still need to obtain your password from the project manager.

8.1 Starting your work: checking out the online project
To start working on an online project, check if you have all the details listed above, and follow the
steps below.
Important: Do this only once, when you start working on the project – do not check out the project
again if you did some work and you simply want to return to the project. After you check out an
online project, you can close and open it again from the Dashboard, just like projects you create
yourself.
1. Open memoQ. In the Dashboard, click the Check out an online project link. Alternatively, you can
choose the Check Out Online Project… command from the Project menu. memoQ displays the
Check out online project dialog:
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2. In the Server URL text box, type or paste the Internet address of the server, then click Select.
3. If this is the first time you connect to that server, memoQ displays the Enter user name and password dialog:

Type your user name in the User name text box, and your password in the Password text box. Use
the details that you received from the project manager.
Note: If you have connected to the same server before, memoQ will not ask for your user name
and password. When you connect to a server for the first time, memoQ saves your name and
password in its settings.
4. memoQ displays a list of projects that exist on the server.
Note: All the projects in the list contain one or more tasks for you. Projects that do not involve
you are not listed.

In the list, click the name of the project you need to work on, and click OK. memoQ downloads
the documents and the resources, and creates a copy of the project on your computer. memoQ
displays the Project home tab for the project, with the Translations pane open.
8.1.1 Using a description file to check out an online project
If you receive an e-mail that contains a project description file, there is an easier way to start working:
1. Close memoQ if it is running. Open the e-mail you received: it will contain an attached file. The
file has the .mqdf extension, and its icon looks like this:
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2. Double-click the icon or the name of the file. memoQ starts automatically, and displays the Enter
user name and password dialog:

Type your password in the Password text box, and click OK.
3. memoQ displays the Check out online project dialog, where the name of the project is already selected:

4. Click OK. memoQ downloads the source documents, and connects to the resources on the server,
and displays the Project home tab for the project.

8.2 Working on the online project
When you check out an online project, memoQ creates a local copy of the project on your computer.
You can open and close this project just like the other projects that you create.
There is one exception: when you open your local copy of the online project, memoQ connects to the
memoQ server, and downloads changes. It also uploads all changes you made to the documents.
When you close the project, memoQ contacts the memoQ server again, and uploads your changes,
and downloads all changes others made to the documents.
Note: If your project manager uses the confidentiality mode in setting up an online project, you
may not be able to use plugins. Depending on the setup, you may not use the Machine Translation, Terminology or TM plugins. After you checked out the project, a message is displayed telling you which plugins are disabled for the project.
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8.2.1 Online project with server documents, online projects with desktop documents
This might not always be the case. memoQ has two types of online projects: one works with server
documents, and the other works with desktop documents:
•

Server documents mean that you do not actually work on a local copy of the documents:
when you work on the translation, and confirm a segment, it is immediately saved to the
server. To work on an online project with live documents, you need to be connected to the
memoQ server all the time. This means you need a continuous Internet connection.

•

Desktop documents mean that you work on a local copy of the documents, and you need to
upload the changes from time to time. You also download the changes that others made.
There is a single command for that, called Synchronize. When you work on an online project
with desktop documents, you do not always need to be connected to the memoQ server.
You can continue working even when you have no Internet connection.
Note: The project manager also has an option to select Desktop documents (with web translation). If this is the case, you can open your browser, enter the credentials provided by the
project manager, and work with memoQwebTrans.

You cannot decide if you want to work with server documents or desktop documents. This is something the project manager decides when she creates the project on the memoQ server.
8.2.2 Synchronizing online projects with desktop documents
When you close your copy of the online project, memoQ asks if you want to synchronize your copy
with the master copy that exists on the server. It is highly recommended that you click Yes: it is like
saving your work at the end of the day. After you synchronize your work with the server, the project
manager will see your progress, and she will also see your translation.
Note: If some of your translation is already synchronized on the server, others can also check out
and open the same document, and do some work on it. For example, a reviewer can access your
translation, and start checking it, even if the translation is still not fully completed.
You can also synchronize your work manually. Navigate to the Translations pane of Project home, and
select one or more documents. Right-click your selection, and choose Synchronize document. memoQ
uploads all your changes, and also downloads changes that others made.
Caution: When your documents are synchronized, some of your work might be overwritten by
changes coming from the server. For example, a reviewer can make a change that takes precedence over your version. memoQ will use change marks to indicate that the segment comes from
the server, and it no longer contains your text. For more information, see the memoQ Help.
Troubleshooting: You might be unable to join or split segments during translation. The project
manager who creates or publishes the project on the server has a setting to disable joining and
splitting. Similar settings may prevent you from seeing the preview or exporting the documents
in the final translated format.
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8.3 Delivering your work
When you complete your translation, you need to let the project manager know that you finished
working on the selected documents or on the entire project. To do this, follow the steps below:
1. Navigate to the Translations pane of Project home.
2. Select the documents that you wish to deliver. Press Ctrl+A to select all documents.
3. Below the list of documents, click Deliver/return. To use this command, all segments must be confirmed in the selected documents. If not all segments are confirmed, memoQ displays a warning
message:

4. If all segments are confirmed, memoQ uploads your changes to the memoQ server if necessary,
and then notifies the project manager that the translation is completed.
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9 Common key shortcuts

Up arrow

Navigates up through the translation grid

Down arrow

Navigates down through the translation grid

Ctrl+Tab

Navigates through the document tabs open in memoQ

Tab

Moves the cursor from the source cell and the target cell, and back
within a segment

Ctrl+Up arrow

Navigates upwards through the translation results

Ctrl+Down arrow

Navigates downwards through the translation results

Ctrl+F4

Closes the active document tab

Ctrl+Spacebar

Inserts the highlighted translation result into the target cell

Ctrl+1 … Ctrl+9

Inserts the translation result #1...9 into the target cell

Ctrl+Shift+N

Moves the selected text one word right

Ctrl+Shift+B

Moves the selected text one word left

Ctrl+Z

Undo: use this to restore your text after you accidentally deleted or
modified something

Ctrl+B

Sets a selected part of the text bold, or – if it is already bold – removes
the bold formatting.

Ctrl+I

Sets a selected part of the text italic, or – if it is already italic – removes
the italic formatting.

Ctrl+U

Sets a selected part of the text underlined, or – if it is already underlined
– removes the underlined formatting.

Shift+F3

Toggles selected text between uppercase and lowercase

Ctrl+T

Splits the current segment at the current position of the cursor

Ctrl+J

Joins the current segment with the next one

F8

Inserts the next formatting tag into the target segment

Alt+F8

Inserts all remaining formatting tags into the target segment

F9

Copies the next inline tag sequence into the target segment

Alt+F9

Copies all remaining inline tags into the target segment

Ctrl+Enter

Confirms the current segment and updates the primary translation
memory with the translation

Ctrl+Shift+Enter

Confirms the segment without adding the translation to the primary
translation memory
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Ctrl+Shift+L

Sets the status of the active or selected segment pairs to locked or if
they are already locked, unlocks them

Ctrl+E

Invokes the Add new term dialog where you can add a new term to the
primary term base – text selected on the source and target sides will be
inserted

Ctrl+Q

Adds a new term to the primary term base without invoking the Add
new term dialog – text selected on the source and target sides will be
added

Ctrl+Shift+S

Inserts the entire text of the source segment into the target cell

Ctrl+Shift+T

Inserts the selected part of the source segment into the target cell

Ctrl+C or Ctrl+Insert

Copies the selected text to the clipboard without cutting it.

Ctrl+V or Shift+Insert

Inserts the text from the clipboard at the cursor position or replaces the
selection with the clipboard's contents

Ctrl+Shift+G

Displays the Go to next segment dialog where you can specify the segment types to jump to when pressing CTRL+G.

Ctrl+G

Jumps to the next segment that meets the segment types specified in
the Go to next segment dialog (e.g. error, empty, pre-translated, repetition etc.)

Ctrl+K

Finds all translation memory entries, the source version of which contain the selected text

Ctrl+P

Displays the Look up term dialog: you can look up terms manually in your
term bases

Ctrl+F

Finds the selected text in the translation grid

Ctrl+H

Replaces the selected text with another one in the translation grid

Ctrl+Num Minus

Inserts an en dash into the target segment

Ctrl+Shift+Space

Inserts a non-breaking space into the target segment

Ctrl+Shift+-

Inserts a non-breaking hyphen into the target segment

Shift+Enter

Sets the segment to Rejected.

Ctrl+F3

Opens the memoQ Web Search window.
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